User’s manual for

METERTOOL for MULTICAL® COMPACT, 66-K

Type No.: 66-99-700

Kamstrup

Kamstrup A/S, Energi Division
Industrivej 28, Stilling,
DK-8660 Skanderborg

TEL: +45 89 93 10 00,

FAX: +45 89 93 10 01

E-MAIL: energi@kamstrup.dk
WEB: www.kamstrup.com



5511-529 GB/DK/99.11/Rev. Al



Contents

English

1.

2.
3.
4

v 0 N o oW

10.
11.
12.
13.

Introduction
Computer and Printer Requirements
Installing the Software

Connecting MULTICAL® COMPACT to
the Computer

Reading data from MULTICAL® COMPACT
Partial Programming

Complete programming

Save Customer

Total Reset

Data Acquisition

Adjusting the printer

Updating/New editions

Alphabetical Register

Dansk

[ERN

v 0 N o W N

Y
w N ~»r O

Indledning

Krav til PC og printer

Installation af software

Tilslutning af MULTICAL® COMPACT til PC
Aflaesning af MULTICAL® COMPACT
Delvis programmering

Fuldstaendig programmering

Save Customer

Total reset

. Dataindlaesning
. Printerjustering
. Opdatering/revisionsstyring

. Alfabetisk register

O 0 00 N N N oo oo oo wum

11
11
11
11
12
12
12
13
13
13
14
14
15

5511-529 GB/DK/99.11/Rev. A1l



5511-529 GB/DK/99.11/Rev. Al



1. Introduction

METERTOOL for MULTICAL® COMPACT has been
developed with a view to giving Kamstrup
distributors, heat utilities and laboratories an

effective tool for programming MULTICAL®
COMPACT.

2. Computer and Printer Requirements

KAMSTRUP METERTOOL can be installed on either
a portable or stationary Pentium personal computer
provided the computer has a minimum of 32 MB
RAM and at least 15 MB space on the hard disk.
The computer must have a 3v2"/1,44 MB floppy
disc drive.

The computer must have a Windows™ 95 or
Windows™ 98 program installed. METERTOOL can
not run directly from the floppy disk - the program
must be installed on the hard disk. The computer
monitor should be min. SVGA with 800 x 600 pixels.

In order to communicate with MULTICAL® COMPACT,
your computer must have a free COM port (COM
1...4) with a 9-pole M-Dsub plug. If your computer
has a 25-pole Dsub plug, use adaptor type 66-99-
120.

3. Installing the Software

First of all check to ensure that the computer

has sufficient space on the hard disk - e.g. via
Windows™ file manager. Close all programs -
including OutLook and Virus scanner. Use “Termi-
nate and log off” for e-mail and InterNet programs.

Insert the first disk into the floppy drive “A” and
select “Run” in the “Start” menu.

Select “A\Setup”

NB: The COMport in a portable computer may be
set to "Low power mode", which will prevent com-
munication with MULTICAL® COMPACT. Disable
“"Low power mode". If in doubt, please contact your
computer supplier.

KAMSTRUP METERTOOL can also be used to print
side labels for MULTICAL® COMPACT. This facility
ensures that relevant installation information and
the type approval numbers can be seen on the
meter. The printer is usually connected to the com-
puter's LPT1 port. Most printer drivers for Windows
can be used. However, make sure that the printer
is able to print on small label sheets (150 x 105
mm).

Original label sheets can be ordered from Kam-
strup A/S, type no. 2008-245.

Follow the directions given by the program, insert-
ing subsequent disks as indicated.

When the installation has been completed, the
METERTOOL icon will be available via the “Start”
menu under “Programs”. Double click on the new
icon to start the program.

To start METERTOOL a printer driver must be
installed in Windows™.

4. Connecting MULTICAL® COMPACT to the Computer

MULTICAL® COMPACT is programmed by means of
serial data transfer between the computer and the
heat meter. This connection can be either an opti-
cal IR head, type 66-99-102 or a data cable, type
66-99-108.

4.1 Optical IR head, type 66-99-102

The optical IR head is ideal for partial program-
ming, i.e. programming that doesn’t affect the
legal parameters contained in PROG = A-B-CCC.

Data communication is established without
opening the meter, providing optimal service
friendliness when changing display readings, tariff
types etc. in the meter.

Place the IR head on the MULTICAL® COMPACT
front panel - between the two guides. The built-in
magnet will keep the IR head in place.

The cable at the base of the IR head must point
downwards +20° to ensure correct communication.
The IR head’s 9-pole Dsub plug should be
connected to one of the computer’s COMports.

& The optical IR head contains a powerful
magnet which must NEVER be placed in the
vicinity of computer disks of any kind.
Always ensure that the protective disk is in
place when the IR head is not in use.
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A The COMport in a portable computer may be
set to "Low power mode", which will prevent
communication with MULTICAL® COMPACT.
Disable "Low power mode". If in doubt,
please contact your computer supplier.

Cable, type 66-99-108

The data cable is particularly suitable for “comple-
te” programming - when all parameters can be
reprogrammed. The verification seal will be broken
when inserting the data cable in MULTICAL®
COMPACTs test plug beneath the top cover. This
gives access to all legal parameters included in
PROG = A-B-CCC.

Please note that MULTICAL® COMPACT must always
be reverified and sealed when the data cable has
been used.

5. Reading Data from MULTICAL® COMPACT

Connect the serial data communication, as descri-
bed above, and start the KAMSTRUP METERTOOL
program with a double click on the icon under
“Programs”.

The first time you start the program, you must select
the appropriate COMport via the “Options” menu.

6. Partial Programming

Partial programming means that the meter is repro-
grammed without breaking the verification seal.
"Program No." (A-B-CCC) is inaccessible during
partial programming. All other parameters can be
reprogrammed.

Start reading the meter parameters by clicking on
“Read meter”. All meter parameters will be trans-
ferred to the computer and displayed on the
screen.

The parameters shown refer to the Technical
Description for MULTICAL® COMPACT.

Partial programming can be used by e.g. heating
utilities or distributors to change display readings,
tariff limits etc., without opening the meter.

7. Complete Programming

To access complete programming, the verification
seal beneath the top cover of the meter must be
broken. When the data cable, type 66-99-108 is
used, the seal will be broken by the pins on the
cable. Complete programming permits the “Pro-
gram No.” to be changed (A-B-CCC). The complete
programming facility should only be used by labo-
ratories who have national authority to verify heat
meters.



8. Save Customer
If you wish to save the set up for each individual M

meter, select “Save Customer” in the “File” menu.

Custormes M Ir;,.a'm-lu_p,ﬂ_.? ﬂ
Type Mo : fesr -R-1-5-4.312
FrogamMa:  [3.4-533
Corfgho: [ 30000
Cusiome: Mo lm
TLZ: ] €«
3. om0
Malwadimsr [T ©
TageiDats: [

Average Period . 5 Min
Telephane Mo 1 [4cg: 20518

Telephare Mo 2 [ 45500 2505

9. Total Reset

METERTOOL can reset all display registers. Select
“Reset” in the “Utility” menu. This function can
only be accessed via the data cable, type 66-99-
108, i.e. breaking the verification seal.

10. Data Acquisition

In order to use METERTOOL correctly, you must be ] #5  BMETEATOOL fos MULTICALS COMPALCT
familiar with all the functions and number systems
in the meter. All relevant information can be found |l &3
in the Technical Description for MULTICAL® :
COMPACT which will be sent to you on request.

Make sure that the clock in the computer you use
is set correctly - the date and time will be transfer- Dus:  FH0E
red from the computer to MULTICAL® COMPACT
during programming.
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Before printing side labels for MULTICAL® [ smmsivnsps 207 ETEATOOL fos WULTICALS CIMPALT
COMPACT, the printer should be adjusted. Select
“Print label” in the “File” menu. Adjust the XY
coordinates via “Set up”.

Each new edition of METERTOOL will indicate that
the program has been revised. The first edition is
Rev. A1.

If you require support or updates to your program,
please state which edition of the program you
have. This information will be displayed, if you
select “About” from the “Help” menu.




13. Alphabetical Register

The alphabetical register below briefly describes
words and phrases used in the program.

This register can be used as a reference when

using the program.

A
A-B-CCC

Address

Average
C

Cccc

Com 1...4

Config. No.

Customer No.

Bate

DD

DD-E-FF-GG

EN1434

Energy

The meter’s program number.
Determines the position of the
flow meter in either flow or
return, measuring unit and
nominal flow rate.

(RS-232) The meter contains
an addressable data sequence
which can be used when
several meters are connected
in a network, e.g. via external
RS 232/485 converters.

Indicates the average period
for measuring peak flow or
peak power.

Flow meter code. E.g.CCC=833
is used for gp 1.5 m3/h.

The computers serial dataport
No. 1, 2,3 or4.

Meter’s configuration No. =
DD-E-FF-GG indicates display
and tariff type.

11-digit customer number
which can be read on the
display. The customer No. can
be changed without changing
the serial No.

The computer’s calender whi-
ch is transferred to the meter.
The format is YY-MM-DD.

Display code, which indicates
the display selected.

The meter’s configuration No.
= DD-E-FF-GG indicates display
and tariff type.

The required tariff is selected
via "E". E.g. E=3 means "coo-
ling tariff", whereas E=0
means "no tariff".

European standard for heat
meters.

Accummulated energy (e.g. in
kWh) stored in the memory
when info-code is changed.

This register is not used in
MULTICAL® COMPACT.

The prevailing water flow can
be used as a basis for tariff
(E=2).

This register is not valid in
MULTICAL® COMPACT.

1
Info code

Info date

[andscape

M
Min

mm

MPE
P
Power

Print

Programming

R
Read meter

S
Save Customer

Serial No.

T
Target date

Tariff limits

Time

TL2
TL3

Type No.

The first info-code that has
occured.

The date on which the info-
code occurred.

Indicates that the sheet with
lables will be printed
horizontally.

The number of minutes select-
ed as average time for peak
flow or peak power. Any num-
ber between 1 ... 120 can be
selected.

The number of millimetres the
font lable print must be adjus-
ted.

Maximum Permissible Error

Prevailing heat power - can be
used as a basis for tariff (E=1).

Starts printing the lable
shown.

Starts programming the meter.
All data shown will be transfer-
red to the meter.

Reads the meter set-up. All
meter data will be displayed.

Stores a set-up in the
database.

Meter serial number.

The annual target date is often
the date on which the utility
calculates and bills consump-
tion. All relevant registers are
stored on the target date for
later use. The format is MM-
DD, where MM=1...12 and DD
=1..28.

Tariff limits determine when
the tariff registers TA2 and TA3
accumulate energy parallel to
the energy display. Tariff limits
are only used with E=1, 2, 3 or
5.

The actual time on the compu-
ter - which is transferred to the
meter during programming.

Tariff limit 2 indicates the start
conditions for TA2.

Tariff limit 3 indicates the start
conditions for TA3.

The meter type No. contains
information pertaining to pow-
er supply, data module, sensor
type and language on the front
lable.
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1. Indledning

METERTOOL for MULTICAL® COMPACT er udviklet
med henblik pd at give sdvel varmevaerker og for-
handlere som laboratorier et effektivt veerktgj ved
programmering af MULTICAL® COMPACT.

2. Krav til PC og printer

KAMSTRUP METERTOOL kan installeres pa sdvel
barbare som stationare Pentium PC'er, med min.
32 MB RAM, samt mindst 15 MB ledig plads pa
harddisken. Desuden skal der veere et 314"/1,44
MB diskettedrev til radighed.

PC'en skal have Windows™ 95 eller Windows™
98 installeret. Programmet kan ikke kgres direkte
fra disketterne, men skal installeres pa harddi-
sken. Den anvendte monitor skal mindst vaere
SVGA med 800 x 600 pixels.

For at opna dataforbindelse til MULTICAL® COMPACT,
skal PC'en have en ledig COMport (COM 1...4) med
9-polet M-Dsub stik. Ved 25-polede Dsub stik i
PC'en, kan adapter type 66-99-120 anvendes.

Bemark at COMporten i baerbare PC'er kan vaere

3. Installation af software

Check fgrst at PC'en har den forngdne plads pa
harddisken, f. eks. ved hjzlp af Windows™ file-
manager. Luk herefter alle dbne Windowsprogram-
mer, herunder ogsa OutLook og Virusscanner.
Anvend "Afslut og log af" ved e-mail og InterNet-
programmer.

Indsat den fgrste diskette i diskettedrevet "A" og
veelg "Kgr" i "Start" menuen.

Veelg herefter "A:\Setup

stillet i "Low power mode", hvormed kommunikati-
onen til MULTICAL® COMPACT ikke vil fungere. Sgrg
for at frakoble "Low power mode". Kontakt evt. PC
leverandgren.

KAMSTRUP METERTOOL anvendes desuden til
udskrift af sideetiketter til MULTICAL® COMPACT,
sddan at relevante installationsforhold samt type-
godkendelsesnummer kan laeses pa maleren.

Printeren tilsluttes normalt til PC'ens parallelle port
LPT1. De fleste printertyper der anvender Windows
driver kan anvendes, men vaer iser opmarksom
pa at printeren skal kunne handtere sma labelark
pd 150 x 105 mm.

De originale labelark bestilles hos Kamstrup A/S,
pa type nr. 2008-245.

Folg herefter anvisningerne i installationsprogram-
met og indsat de resterende disketter nar pro-
grammet anviser det.

Nar installationen er udfart, vil ikonen METERTOOL
veaere tilgaengelig i "Start" menuen under "Program-
mer". Dobbeltklik pa den nye ikon for at starte pro-
grammet.

Opstart af METERTOOL kraever at der er
installeret printerdriver i Windows™.

4. Tilslutning af MULTICAL® COMPACT til PC

MULTICAL® COMPACT programmeres ved seriel
dataoverfgrsel mellem PC'en og energimaleren.
Dataforbindelsen kan etableres ved hjzlp af et
optisk laesehoved, type 66-99-102 eller ved hjzelp
af datakabel type 66-99-108.

4.1 Optisk leesehoved, type 66-99-102

Det optiske laeesehoved er idéelt til "delvis" pro-
grammering, hvor der ikke er behov for at @ndre
de legale parametre indeholdt i PROG = A-B-CCC.

Datakommunikationen etableres uden at dbne
maleren, hvilket giver optimal servicevenlighed
ved f.eks. @ndring af displayvisninger og tariftyper
i maleren.

Det optiske leesehoved placeres pa forpladen af
MULTICAL® COMPACT mellem de to stag, hvor
leesehovedets indbyggede magnet fastholder det
pa forpladen. Laeesehovedets kabel skal vendes
nedad +20° for at sikre korrekt kommunikation, og
lesehovedets 9-polede Dsub stik skal tilsluttes en
af PC'ens COMporte.

& Det optiske leesehoved indeholder en kraftig
magnet. Anvend det derfor aldrig i naerheden
af disketter og harddiske. Pdset altid den
medfglgende metalskive, nar l&esehovedet
ikke anvendes.

5511-529 GB/DK/99.11/Rev. Al
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|\ Bemeaerk at COMporten i barbare PC'er kan
veere stillet i "Low power mode", hvormed
kommunikationen til MULTICAL® COMPACT
ikke vil fungere. Sgrg for at frakoble "Low
power mode". Kontakt evt. PC leverandgren.

4.2 Datakabel, type 66-99-108

Datakablet egner sig iseer til "fuldstaendig" pro-
grammering, hvor under samtlige parametre i
maleren kan omprogrammeres. Nar datakablets
stik placeres i MULTICAL® COMPACTs teststik under
topdakslet, brydes verifikationsplomben, hvor-
med der opnds adgang til at &ndre de legale para-
metre indeholdt i PROG = A-B-CCC.

Bemaerk at MULTICAL® COMPACT altid skal re-verifi-
ceres og plomberes, nar datakablet har vaeret
anvendt.

5. Aflasning af MULTICAL® COMPACT

Tilslut den serielle datakommunikation som
beskrevet ovenfor, hvorefter KAMSTRUP METER-
TOOL startes ved at klikke pa ikonen under "Pro-
grammer". Fgrste gang programmet startes, skal
COMporten vaelges under "Options" i topmenuen.

Start med at leese malerens parametre ved at

klikke pa "Read meter". Herved overfgres alle

[Qcamenan A3 WETERTOSL |t MRTHALS CPADY
Pla U [psom ihios (it

malerens parametre til PC'en, hvor de vises pa
skaermen.

De viste parametre refererer til Teknisk Beskrivelse
for MULTICAL® COMPACT.

6. Delvis programmering

Delvis programmering betyder, at maleren kan
omprogrammeres uden at bryde verifikationsplom-
ben. Dette indebaerer, at "Program No." (A-B-CCC)
er speerret. Alle de gvrige parametre kan dog
omprogrammeres.

Delvis programmering anvendes f.eks. af varme-
vaerker og forhandlere, der uden at dbne maleren,
kan aendre f.eks. displayvisninger og tariflimits.

7. Fuldstandig programmering

Denne type programmering kraever, at verifikati-
onsplomben under topdaekslet brydes. Nar dataka-
bel, type 66-99-108 anvendes, vil plomben brydes
af datakablets stikben. Fuldstaendig programme-
ring tillader omprogrammering af "Program No." (A-
B-CCQ). Fuldsteendig programmering bgr kun
anvendes pad laboratorier, som har national
bemyndigelse til at foretage verifikation af energi-
malere.



8. Save Customer
Hvis opsatningen af de enkelte mélere gnskes [EM

gemt under et kundenavn, veaelges funktionen
"Save Customer" under "File".

Custormes M Ir;,.um-"m,ﬂ_.? ﬂ
Type Mo : fesr -R-1-5-4.312
FrogamMa:  [3.4-533
Cofgho: [z50000
CustormiBo:  [isaszioon
TL2: .00 €«
TL3:

Hitlie Adigs: |:|_ T
TageiDate: e 07

Average Period . 5 Min
Telephane Mo 1[40 20518

Telephare Mo 2 [ 45500 2505

9. Total reset

METERTOOL kan udfgre nulstilling af alle displayre- [Fi e el S S L O R ey e e
gistre ved at veelge "Reset" under "Utility". Funktio-
nen kan dog kun anvendes sammen med dataka-
bel type 66-99-108, hvorved verifikationsplomben
brydes.

Hﬂth.-

10. Dataindlaesning

Det er naturligvis ngdvendigt at kende alle funktio- [ 45 WETEATOOL fos HULTICAL® DOMPALT
ner og nummersystemer i maleren, inden arbejdet
med METERTOOL pabegyndes. Rekvirér Teknisk
Beskrivelse for MULTICAL® COMPACT, hvori alle
relevante oplysninger om maleren er beskrevet.

Det er endvidere vigtigt, at den anvendte PCs inter-
ne ur er stillet korrekt, da data og klokkeslaet over-
fgres fra PC'en til MULTICAL® COMPACT ved pro-
grammering.

5511-529 GB/DK/99.11/Rev. Al
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Forud for udskrift af sideetiketter til MULTICAL®
COMPACT, skal der foretages indstilling af den til-
sluttede printer. Veelg "Print label" under "File",
hvorefter "Set up" giver adgang til at justere XY-
koordinaterne.

Ved opdatering af METERTOOL bliver revisionsnum-
meret andret. Ved kontakt til KAMSTRUP A/S

angdende opdatering af Deres program, bedes rev.
nr. oplyst. Find "About" under "Help" i topmenuen.

[ amatvas

ITOOL ds HULTICA




13. Alfabetisk register

Nedenstdende alfabetiske register forklarer de
udtryk, der fremkommer pa skaermen.

Registeret kan bade leeses som information og bru-

ges som opslagsregister, nar der opstar et spgrgs-

mal.

A
A-B-CCC

Address

Average
C

Cccc

Com 1...4

Config. No.

Customer No.

Bate

DD

DD-E-FF-GG

EN1434

Energy

Malerens programmerings-
nummer. Bestemmer flow-
malerens placering i frem-
eller returlgb, maleenhed og
nominelt flow.

(RS-232) Maleren indeholder
en adresserbar datasekvens,
som kan anvendes, nar flere
malere er sluttet sammen i et
net, f.eks. via eksterne RS
232/485 convertere.

Angiver den midlingsperiode,
over hvilken spidsflow eller -
effekt males.

Flowmalerkode. F.eks. anven-
des CCC=833 for gp 1,5 m3/h.

Computerens serielle dataport
nr. 1, 2, 3 eller 4.

Malerens konfigurationsnr. =
DD-E-FF-GG angiver displayvis-
ning og tariftype.

11-cifret kundenummer, som
kan afleeses pa displayet. Kun-
denummeret kan &ndres uden
at @ndre serienummeret.

Computerens kalender, som
overfgres til maleren. Formatet
er YY-MM-DD.

Displaykode, som angiver den
valgte displayvisning.
Malerens konfigurationsnr. =
DD-E-FF-GG angiver displayvis-
ning og tariftype.

Den gnskede tarif vaelges ved
hjeelp af "E". F.eks. betyder
E=3 "afkglingstarif", hvorimod
E=0 betyder "ingen tarif".
Europaisk standard for varme-
malere (Rekvireres hos Dansk
Standard).

Den opsummerede energi
(f.eks. i kWh) lagres i hukom-
melsen, ndr info-koden aend-
res.

Dette register anvendes ikke i
MULTICAL® COMPACT.

Det aktuelle vandflow kan bru-
ges som tarifbasis (E=2).

Dette register anvendes ikke i
MULTICAL® COMPACT.

1
Info code
Info date

L
Landscape

M

Min

MPE

P
Power

Print

Programming

R
Read meter

S
Save Customer

Serial No.

T
Target date

Tariff limits

Time

TL2
TL3

Type No.

Den fgrst opstdede Info-kode.

Den dato, hvor infokoden
opstod.

Betyder, at ark med fronteti-
ketter udskrives liggende.

Det antal minutter, der er valgt
som middeltid for spidsflow
eller spidseffekt. Kan vaelges
mellem 1 ... 120 Min.

Det antal millimeter, fronteti-
kettens udskrift skal justeres
med.

(Maximum Permissible Error)
Max. tilladt fejl.

Den aktuelle varmeeffekt kan
bruges som tarifgrundlag
(E=1).

Starter udskrivning af den
viste label.

Starter programmering af
maleren. Alle de viste data vil
blive overfgrt til maleren.

Aflaeser malerens opsatning.
Alle malerens data overfgres til
display.

Lagrer en opsatning i databa-
sen.

Malerens serienummer.

Den arlige skaringsdag er som
oftest fjernvarmevaerkets
afregningsdato. Pa skaerings-
dagen lagres alle relevante
registre til senere aflaesning.
Formatet er MM-DD, hvor
MM=1...12 og DD = 1...28.

Tarifgreenserne bestemmer,
hvornar tarifregistrene TA2 og
TA3 skal opsummere energi
parallelt med energivisningen.
Tarifgrenserne bruges kun
med E=1, 2, 3 eller 5.

Computerens aktuelle tid, som
overfgres til mdleren ved pro-
grammering.

Tarifgraense 2 angiver startbe-
tingelserne for TA2.

Tarifgreense 3 angiver startbe-
tingelserne for TA3.

Malerens typenummer inde-

holder information om strgm-
forsyning, datamodul, fglerty-
pe og sprog pa frontetiketten.
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